
 

 

  

SDL TRIDION 2013 
USER MANUAL 

 

This training allows maintaining the existing pages and 
creating new ones using SDL Tridion. You will learn how 
to Log into SDL Tridion, make text changes, make new 
pages, make a link, add images, insert or edit a table, upload 
documents, and send work for approval. 

     Inline Editing: 
Edit existing page 
and create a new 
page. 
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Browsers 
Tridion SiteEdit is compatible with all the browsers, however it is recommended to use Firefox.  

Pop-ups blocker should be set to allow tcm pages to open. 

Log-in 
Navigate to the page to edit, and delete www and replace it with https://stage and click enter. 
You may want to bookmark this page for future editing. 

Click the SDL Tridion button 

 

In the logging window enter UML email address and password. 

Once the logging is successful, the ribbon toolbar appears, set to the Home tab. 

 

Editing existing page 
 

Click on the content to see the border, and borders appear around editable pieces. 

If the ribbon toolbar can be seen, but not the contents of the Web page, the browser may be preventing 
the content from being displayed because it does not consider the content secure. If this happens, do 
the following: 

• In Google Chrome, click the shield icon at the right hand side of your address bar and select 
Load anyway. 

• In Mozilla Firefox, click the shield icon on the left hand side of the browser address bar and 
select Disable Protection on This Page. 

• In Internet Explorer, a message appears on the bottom of the Web page: "Only secure content is 
displayed." Select Show all content next to the message. 

 
Tridion Experience Manager draws borders around editable areas in the web page (see image below) 
 
 

https://stage/
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Web page (1) 
If the Web page as a whole is editable, 
Experience Manager draws a border 
around it. 
By default, you only see it when 
hovering over the edge of the page, but 
you can make it always visible. 
Component (2) 
If a Component on the Web page is 
editable, Experience Manager draws a 
border around it. By default, you only 
see the border when hovering over the 
Component, but you can make it always 
visible. 
Field (3) 
If a field of a Component is editable, 
Experience Manager draws a border 
around it, but only if you select the 
Component first and then hover over 
the field. This also goes for fields within 
fields (4). 

 

Borders and colors 

The color of an item border tells you something about the status of that item. 
By default, an item can have a border in one of the following colors: 
Blue 
A blue border indicates that you can edit the item. 
 
Green 
A green border means that there are pending changes to this item for you to commit or discard. 
 
Red 
A red border means that your changes cannot be saved, because the content you entered is invalid or 
incomplete. 
 
Grey 
A grey border means that you cannot (currently) edit this item.  
 
These colors are defaults. Your application administrator may have changed them. 
The color of borders around the fields of a Component are as follows: 

• If the Component has a blue or green border (or its configured alternative), so do all of its fields. 
• If the Component has a grey border (or its configured alternative), its fields have no borders. 
• If the Component has a red border (or its configured alternative), the field or fields that are 

invalid also have a red border. 
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Auto save is enabled, there is no need to save changes that is why the Save 
Draft function is grayed out 

Fonts 
For design purposes, the font style and the color are not to be changed. 

If the content is prepared in a Word document, copy and paste to Notepad or other text editor first then 
copy from Notepad to your page. To format the content you can use Text Field Properties or the 
formatting toolbar. 

 

Text Field Properties 

 

Formatting Tool bar 

The first title in the component is always heading 2 by default. The green title formatting will be 
discussed in the creation of a new page. 

Heading 
Only heading 2 and heading 3 are used in editing content in Tridion. To apply a header to a content box, 
highlight the words you want in the headline and select heading 2 or heading 3 from Section Type in the 
formatting tool bar. Or just place the cursor in the line that needs the header change and select an 
option (2 or 3 only) from the dropdown menu. 
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Example of heading 2 

  

 

Example of heading 3 

Title 3 to be heading 3      

 

Email Link  
 

To link to an email address, highlight the content you wish to link (it is preferable to type the whole 
email address), in the ribbon tool bar select Insert tab 

 

Then click Hyperlink. 
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Now under Type field select mailto, in the URL field after mailto:(no space) type the 
appropriate email address, and in the Title field add a description of the email (or the person’s 
name), then click OK. 

 

Add an Image 
Click at the beginning of the paragraph when you want to insert the image. 

 

Select the Insert tab in the formatting toolbar 

 

 

 

Then click Image button 
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After the Image pop up window is displayed 

 

A window slide on the left will display the folder Building Blocks, click on the arrow. 

 

Then click Content. 
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Navigate to the desired folder within your department folders. 

Go to Multimedia folder. 

 

Click Images folder. 

 

Select the image you want to insert. 

 

 

And click Select on the top of the slide window. 
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Click Advanced to format the image. 

• In the Text field type a good description of the image 
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• In the Alignment field select the desired location (mostly float left or float right) 

 

• The maximum Width should not exceed 200 
• The maximum Height should not exceed 200 
• Keep the Proportion field checked 
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Then click OK. 

Upload an Image 
To upload an image to be added to the page, follow the same procedure to add an image until the step 
where Image folder is opened. 

Click at the beginning of the paragraph when you want to insert the image. 

 

Select the Insert tab in the formatting toolbar. 
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Then click Image button. 

 

After the Image pop up window is displayed. 

 

A window slide on the left will display the root folder Building Blocks, click on the arrow. 
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Then click Content. 

 

 

Navigate to the desired folder in your department. 

Go to Multimedia folder. 

 

Click Images folder. 

 

At the bottom you will find the area where you have an option to drag and drop or upload the image. 

 

Drag and drop is straight forward. 



 

 14 

Click to upload will prompt a new window, which will allow you access to your computer or shared drive 
or USB drive 

 

Find the image you want to use, select then click Open. 

The Metadata window is open to edit the image’s alt text. 
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Make it a good description, then click Save and Close 

After this step click cancel, click outside the component, then click back inside it. 

Follow the instructions in “Add an image “paragraph. 

Link to pdf, Word doc, Excel, PowerPoint 
 

Type the name of the text file you want to add to your page, and add the extension in parentheses in 
the format below: File name (file extension). 
For example: Test 1(pdf), or test 2 (doc) … 

highlight the name of the file but not the parenthesis. 

In the ribbon toolbar select Insert tab. 

 

Then click Hyperlink. 
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In the following popup window select Component for Type and New Window for Target. 

 

 

Click browse button.                         

A window slide on the left will display the Building Blocks folder, click on the arrow. 

 

Then click Content and navigate to the desired folder. 
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Inside the desired folder click to navigate to docs folder where all the pdf, word documents and excel 
files are stored. 

 

Click on this folder, and locate the file you want to use. 

 

Then click Apply. 

 

In the Hyperlink window, click OK. 
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Upload a pdf, Upload a pdf, a Word document, Excel, or PowerPoint 
presentation 
Highlight the content to be linked to the file. 

 

In the ribbon toolbar select Insert, then Hyperlink. 

 

Select Component, and set the Target to New window. 

 

In the slide window navigate to the right folder. 
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Then navigate to docs folder within your department. 

 

Click on the folder. 

Then drag and drop the file in the bottom field. 

 

And click Apply. 

 

 

Then click OK in the Hyperlink window. 
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External Link 
Any link outside of Tridion is considered external link. A typical Tridion page is in the format: 
www.uml.edu/dept/.../PageName.aspx 

Highlight the content to be linked, and in the ribbon toolbar select Insert tab, then Hyperlink. 

 

In the following popup window select HTTP:// for Type. And New Window for Target. 

Type or copy and paste the address in the URL field. In case if you paste it make sure the new 
address does not duplicate “http://”. 

 

Check if the link is working by clicking folder/arrow icon.  

Internal link 
Any link within Tridion (www.uml.edu/dept/.../PageName.aspx) is considered an internal link and linking 
to a Tridion page is done by linking to the component used by that page. Whereas The URL of the page 
you are trying to link to can change and the only way to avoid a broken link is to navigate and link to the 
component used by that page.  

http://www.uml.edu/dept/.../PageName.aspx
http://www.uml.edu/dept/.../PageName.aspx
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First highlight the content to link then select the Insert tab in the ribbon tool bar 

 

 

Then click Hyperlink. 

 

In the next window select “Component” under Type, and Default for Target. 

 

 

Then click the browse button. . 

A slide window will appear in the left. 
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Click on arrow next to Building Blocks. Then click Content. 

 

Navigate to the desired folder. 

 

Once in the right folder look for the component. 
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Select the component you want to use, and then click Apply on the top of the slide. 

 

 

 

The title field should provide a description as to where the link takes you. Once done, click OK. 
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How to locate a component used by an internal page 
Open the page to link to, then change www in the URL with https://stage  and log-in to Tridion. 

Click inside the component. 

In the ribbon toolbar under Home tab click in Open in Form View. 

   

Click the Info tab. 

 

In the example below: the component name is “test-Amy” and the location is the main “Admissions” 
folder 

 

 Will be the component and the name will be displayed at the right 

And  

 will show the component’s location in the Content Manager (back-end). 

Then you follow the procedure under Internal Link section. 

 

Note 
When linking to landing pages, select a component named “link this for 
the dept. landing page.”    

https://stage/
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Adding a Table 
Place your cursor at the location where you want to insert the table. In the ribbon toolbar click 
Insert tab, then Table button.  

 

When Insert Table window appears, enter the numbers of rows and columns. Click OK when 
done. 

 

A table editor window will pop up. 

By default the content will be Body style (normal formatting). 

To make table heading: select Row tab, click inside the row, and in the Row Formatting menu in the 
Body/Header/Footer section select Header. 

 

Then click OK. 
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In SiteEdit mode click inside the cell and type the table content. 

 

 

Edit an Existing Table 
To edit an existing table click inside the table,  

 

In the formatting toolbar select Format then under Current Elements drop down menu select 
*Table<table>, then click Table button under Insert tab. 

 

In the Table Editor window click inside any cell to activate the top menu which will allow you to 
remove/insert row above or below,  remove/insert column to the left or to the right … 

 

Apply the changes, and click OK. 

To finish editing the page at a later time 
Click the link icon  in the top right of the editable border. 
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Copy and save your URL somewhere where you can easily find it. 

Then click the  in the top right of the Tridion page not the browser. 

 

Click Continue editing later.  

When ready to edit the page just paste the saved URL, and log-in to Tridion. 

When prompted with the message. 

 

On the page’s top right click to update. 

Or Click Update Preview in the ribbon toolbar 
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How to preview the changes before submitting to workflow 
After editing the page, click outside the component being edited. 
Under Home tab in the ribbon toolbar, click Finish Editing. 

 

 

To preview the page before submitting,  click Things to do tab in the top left  

 

Select the component to preview 

 

Click Finish Activity 
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And in the Next activity drop down menu select Publish for Preview 

 

Then click Done 
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Now copy the stage page url by click  

 

Paste it in a new browser tab to check the links and the page layout. 

Now go back to “Things to do” and click “Assigned”. Select the component you are working on and  

 

Click Start Activity if more edits are required, and click inside the component. Otherwise follow the next 
steps. 

Submit to the Workflow 
Click Finish Activity 
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Finish Activity Message: In the comment box type the summary of all the edits and a message to the 
webcontent team if needed. Remember when you submit to the workflow, by default the page will be 
published live. If you want the page to go stage only, you need to mention it in the comment box and 
type”publish stage only”. Also if you need to add a page to navigation (left hand menu in the live 
website) mention it in the comment box and specify the exact location in navigation. 
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In the Next Activity menu select Submit to workflow, and click Done 

Then click Done. 

 

Create a New page 
Under the ribbon toolbar, select Home tab then click New Page. 

 

Select a specific page in your department from the slide window to the left. 

For Admissions website use either: 

• Admissions News page 
• Admissions Page with Picture  and sidebar (level 2) 
• Admissions page with Picture (level 3) 
• Admissions Page without Picture 

 

For other departments “Admissions” will be replaced by your department name automatically. 



 

 33 

Click Create. 

 

In the pop-up window fill in the Page Title, and the File Name. In the File Name use a dash and avoid 
spaces. 

 

Changing the page and the Component locations 
You can change the page location if needed (if you have more than one folder in your department) by 
clicking Change next to Page location field. 

 

And in the window slide navigate to the right folder (pink color) then click Change. 
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If you need to change the location of the component click . Then 

click browse . 

 

Navigate to the desired folder (yellow color), and select. 
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Click Apply. 

 

Click Create Page. 
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The page will reload with a blank page. 

 

To change the green title select Open in Form View under Home tab in the ribbon toolbar. 

 

The page will be open in the back-end of Tridion rather than Experience manager (SiteEdit). 

You can edit the display title and add a navigation title if needed. 
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In this step the page template can be changed from level 4 to level 2 or level 3 or vice versa. 

In the page template drop down menu select level 2 or level 3 

 

Then add a feature image (Feature image is required for level 2 and level 3 pages).  

Note: Feature image must be optimized by the Webcontent team to fit the customized area in the page. 
Please email all images to be optimized to webcontent@uml.edu. 

In the feature image box click browse 

 

And in the new pop-up window navigate to the folder containing the feature image: 

Department/multimedia/Feature image folder 

Select the image and click Insert, then click Save and Close on the page’s top left. 

Component in new page 
When a new page is created using department template, the component will be created automatically 
once the page is reloaded. 

 

You can use the steps in the editing an existing page to edit this component and submit to the work 
flow. 
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Adding a New Component 
In the ribbon toolbar, click Home tab then under Insert Content select Create and Insert new Content. 

 

 

In the slide window click Main Content then click Choose. 

 

In the pop-up window fill the Content Title and make it the same name as the page.  

Change the location by unchecking the Use Default Folder and click browse, navigate to the folder 
corresponding the page’s folder (same name just the color is yellow). Then click Create and Insert 
Content. 
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Note: Name the component the same name as the page 

After the page is refreshed (automatically) the component is added to the page, and it displays a 
heading and content allowing edits. 

 

To start editing just click inside the content, and follow the directions from the beginning of this manual. 

To submit to the workflow 

Under Home tab in the ribbon toolbar, click Finish Editing. 

 

CMS Training  Cumnock C-7, One University Avenue, Lowell, MA  01854 

Phone: 978-934-1873 Fax: 978-934-3033 Contact Us 

01/07/2015 by Hichame Asrary 
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